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Our History
Commdex Consulting, LLC, is a wireless systems integrator headquartered in Norcross, Georgia 
specializing in design and implementation of wireless solutions. Commdex provides infrastructure 
engineering and management consulting services to the telecommunications industry across the 
country. Since inception in 2001, Commdex has designed and implemented numerous wireless 
systems nationwide utilizing the most sophisticated features and functionality. 

What We Do
Commdex provides the finest management services and solutions for telecommunications networks 
from concept to completion. We specialize in providing 'tailor-made' network solutions to 
telecommunications service providers and manufacturers for the deployment of telecom networks, 
facilities and supporting systems. We deliver quality services utilizing the most up-to-date and leading-
edge technology and methodologies.

Our depth of experience in implementing single and multi-site telecom networks and switching 
systems enables us to provide highly responsive and cost effective solutions. Through our efficient 
management and quality consulting services we ensure that our clients get maximum return on 
investment by managing systems to meet their current and future needs. Commdex understands the 
unique needs of wireless infrastructure, and develops solutions to address those individual needs.

Our Values
Our customers are our passion. We believe that the most effective way to service our clients is by 
dedicating ourselves to their objectives. We embrace your goals, commit to your mission and always 
act in your best interests.  

At Commdex, our clients' goals are our obsession - we listen intently and innovate to help you 
achieve your objectives.  We are responsive to your needs and believe in providing the right solution 
the first time.  We are very careful about making promises to our customers.  And, when we make a 
promise, we honor that commitment. 

Our Growth and Stability
Our track record of successes and satisfied customers speaks volumes. Because of our quality service, 
satisfied clientele, and repeat business, Commdex has grown by more than 25% each year since 
inception with more than 90% of our business coming from repeat customers and customer referrals.  
All through this growth Commdex has remained profitable and debt free, which has allowed us to 
service our customers and employees at the highest level.



Benefits clients can realize when working with 
Commdex professionals:

Depth of experience – nationwide
COMMDEX brings a tremendous depth of experience in designing and managing telecom 
systems.  Our consultants are seasoned and certified professionals in their fields with an 
average of 15+ years of experience in the telecommunications industry. Commdex has 
successfully planned, executed, controlled and delivered numerous projects throughout the US.

Field operations management – your “eyes and ears on the ground”
Take confidence in delegating field operations without losing control.  You will be an integral 
part of the loop without the headache and responsibility of day-to-day implementation. Our 
team will gladly assume responsibility for assigned elements of the project and manage them 
from beginning to end. We will establish and track schedules as well as pricing at all stages of 
project to ensure their completion within budgetary and time constraints. 

Sound project strategies
Our consultants facilitate creative and practical design solutions by introducing different 
perspectives into the project.  In addition, we will ensure that project recommendations meet all 
your business objectives, engineering criteria, and are economically feasible. Commdex utilizes 
state of the art software applications to manage the project and communicate real-time 
progress reports. 

Technical and creative counsel
Our staff is skilled across all project disciplines. We offer you sound advice based on years of 
experience, clear direction, and honest, unbiased project assessments. Commdex's obligation 
on the project (contractual or otherwise) is always to our customer. We will operate as your 
agent to ensure that all design specialist, contractors, and subcontractors operate with your best 
interests in mind! 

Teaming partners
Through our vast project experience, working relationships and knowledge base, Commdex 
has built contacts and relationships with some of the leading suppliers and subcontractors in the 
country.  Should the need arise for ancillary services, rest assured that our partner providers 
are an extension of the quality and integrity standards found at Commdex.

Client BenefitsClient Benefits

Client Added Value
Resource Staffing Flexibility
» Commdex staff assigned on an as-needed basis 
» Staffing based on anticipated work load
» Customers able to focus on core business processes

Faster Implementation
» Project completion ahead of schedule
» Manage efficient interaction among teams
» Project tracking and coordination

Quality Assurance
» Continuous monitoring of work product
» Exception reporting and progress assessment
» Test and acceptance

Risk Mitigation
» 
» Identify and resolve risks quickly and efficiently
» Constant critical path, issues and budget monitoring

Single Point of Contact
» Simplified reporting procedures
» Detailed comprehensive status reports
» Certified professionals manage day-to-day activities

Cost Reductions
» Reduction in staffing
» Maximized value from service providers
» Leverage Commdex experience 

Strong risk mitigation process
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COMMDEX'S Wireless Engineering services supplies our customers 
with the necessary engineering expertise and state-of-the-art management 
tools to successfully implement wireless solutions.  We will assist you with 
the development of your technology migration paths.  In addition, our 
engineers will create a deployment plan that facilitates the most strategic 
project decisions. 

COMMDEX Wireless Engineering will support you with a complete 
suite of services including:

uDesign for your optimal wireless solution 
uDeployment of the designed systems
uSystem testing
uIntegration of the wireless solution with existing systems

Wireless Engineering Solutions
Technologies System Deployment
» »Broadband wireless (WiFi/Mesh) Pre-deployment site surveys and site 
» selectionTerrestrial systems (cellular, land mobile 

»radio) Fleetmapping and subscriber templates
» »Point to point microwave and satellite Network installation management 

»systems Fleet tracking and management systems
» Integrated voice, video, and data 

portable systems System Testing
» In-building wireless networks » Acceptance testing plans 
» Emergency services data systems » Coverage drive test

» RF product evaluation and testing 
System Design
» Wireless system and customer needs Rebanding Services 

analysis » Inventory of existing equipment
» Technology and product selection » Suitability assessment
» RF coverage modeling and analysis » Cutover, transition and fallback planning
» Antenna system design and mapping » Evaluation of interoperable communications 
» Design of cell structure, security protocols needs
» System capacity and grade of service » System baselining

analysis » Management system modifications
» Bandwidth and link budget analysis
» Inter-modulation analysis, frequency 

planning
» Co-channel and adjacent channel 

interference analysis

Wireless EngineeringWireless Engineering
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Management Solutions

COMMDEX’s Management Consulting Services provide you with the 
appropriate expertise required to make the optimum managerial solution for critical 
needs of your telecommunications projects.  

COMMDEX Management Consultants bring a tremendous depth of experience 
in managing telecom systems.  We will assist you with developing the most 
comprehensive solutions for effectively managing your telecom systems integration 
project from concept to completion. Our core capabilities include:

Assessment and analysis of critical situations to develop practical action plans
Strategy recommendations for your new initiatives  
Design of effective management processes for your projects 
Re-engineering of existing operations to optimize results and minimize costs.

COMMDEX’s Management Consulting Services provide you with the 
appropriate expertise required to make the optimum managerial solution for critical 
needs of your telecommunications projects.  

COMMDEX Management Consultants bring a tremendous depth of experience 
in managing telecom systems.  We will assist you with developing the most 
comprehensive solutions for effectively managing your telecom systems integration 
project from concept to completion. Our core capabilities include:
�Assessment and analysis of critical situations to develop practical action plans
�Strategy recommendations for your new initiatives  
�Design of effective management processes for your projects 
�Re-engineering of existing operations to optimize results and minimize costs.

Telecommunications 
Strategy Development

Technology Evaluation and Consulting

QA/QC Program Development and 
Implementation

» Identification and assessment of technical and/or regulatory 
alternatives

» Rapid assessment and analysis of critical situations
» Recommendations that attain organization goals
» Design review/alternatives assessment

» Assessment of wireline and wireless telecom technologies
» Determination of appropriate application and IT architectures
» Assistance with process, function and information 

requirements
» Formulation of systems development programs & projects

» Assessment of quality issues
» Support during implementation of QA/QC programs

Telecommunications 
Strategy Development
» Identification and assessment of technical and/or regulatory 

alternatives
» Rapid assessment and analysis of critical situations
» Recommendations that attain organization goals
» Design review/alternatives assessment

Technology Evaluation and Consulting

» Assessment of wireline and wireless telecom technologies
» Determination of appropriate application and IT architectures
» Assistance with process, function and information 

requirements
» Formulation of systems development programs & projects

QA/QC Program Development and 
Implementation
» Assessment of quality issues
» Support during implementation of QA/QC programs

Strategic Planning 

Process Design/Optimization

Systems Integration

Business Consulting

» Customer requirement gathering and analysis
» Management of strategic planning initiatives
» Transition planning and cutover execution
» Assistance with federal, state and municipal approvals
» Change management

» Develop business cases
» Feasibility studies
» Customer needs and requirements analysis
» Cycle-time Analysis and Improvement Recommendations 
» Quantitative and qualitative analysis

» Write telecommunications system specifications
» Assist with network planning and design
» Manage wireless infrastructure installs

» Strategic Planning
» Performance Management/Balanced Scorecard
» Communications Assessments
» Continuity of Operations Planning

Strategic Planning 
» Customer requirement gathering and analysis
» Management of strategic planning initiatives
» Transition planning and cutover execution
» Assistance with federal, state and municipal approvals
» Change management

Process Design/Optimization
» Develop business cases
» Feasibility studies
» Customer needs and requirements analysis
» Cycle-time Analysis and Improvement Recommendations 
» Quantitative and qualitative analysis

Systems Integration
» Write telecommunications system specifications
» Assist with network planning and design
» Manage wireless infrastructure installs

Business Consulting
» Strategic Planning
» Performance Management/Balanced Scorecard
» Communications Assessments
» Continuity of Operations Planning

Management ConsultingManagement Consulting
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COMMDEX's Program Management Services are available during any stage of your 
project.  From project concept to the commissioning of operations, our #1 goal is to deliver to 
you, our customer, an efficient and cost effective systems design and solution. We accept full 
ownership and responsibility for developing, establishing and tracking project timelines and 
pricing schedules throughout the term of the project helping to ensure completion within budget 
and project deadlines.

COMMDEX Program Managers are certified Program Management Professionals (PMP) with 
over 10 years of experience in the field of telecommunications management solutions.  Our 
highly experienced Program Management personnel will deliver comprehensive solutions 
utilizing the most current methodologies, procedures, databases and project tracking tools 
available in the industry.  

COMMDEX Program Managers become the single-point contact to coordinate and oversee all 
technical aspects of your network deployment. By working closely with you during the project 
planning stage, our Program Management team will create the optimum solution, while 
addressing the critical project components of quality, cost, and scheduling. 

COMMDEX's Program Management Services are available during any stage of your 
project.  From project concept to the commissioning of operations, our #1 goal is to deliver to 
you, our customer, an efficient and cost effective systems design and solution. We accept full 
ownership and responsibility for developing, establishing and tracking project timelines and 
pricing schedules throughout the term of the project helping to ensure completion within budget 
and project deadlines.

COMMDEX Program Managers are certified Program Management Professionals (PMP) with 
over 10 years of experience in the field of telecommunications management solutions.  Our 
highly experienced Program Management personnel will deliver comprehensive solutions 
utilizing the most current methodologies, procedures, databases and project tracking tools 
available in the industry.  

COMMDEX Program Managers become the single-point contact to coordinate and oversee all 
technical aspects of your network deployment. By working closely with you during the project 
planning stage, our Program Management team will create the optimum solution, while 
addressing the critical project components of quality, cost, and scheduling. 

Program Management Solutions
Project Implementation Services
» Forecasting
» Value Engineering
» Cash-Flow Analysis and Trending
» Contract Document Review
» Contract Administration
» Customer Relations
» Vendor/Contractor Pre-qualification
» Bid Evaluation
» Vendor Selection 
» Overall Deployment Program
» Tracking and Coordination
» Detailed Design Reviews
» Test and Acceptance
» Exception Reporting and Progress Assessment

Project Implementation Services
» Forecasting
» Value Engineering
» Cash-Flow Analysis and Trending
» Contract Document Review
» Contract Administration
» Customer Relations
» Vendor/Contractor Pre-qualification
» Bid Evaluation
» Vendor Selection 
» Overall Deployment Program
» Tracking and Coordination
» Detailed Design Reviews
» Test and Acceptance
» Exception Reporting and Progress Assessment

Project Planning Services
» Feasibility Studies
» Risk Planning
» Implementation Strategy Development
» Scope of Work Development
» Program Development Management
» Engineering Design and A&E Team 

Evaluations
» Estimating
» Budgeting  
» Critical Path Scheduling (MS project, 

Primavera,Clarity)

Project Planning Services
» Feasibility Studies
» Risk Planning
» Implementation Strategy Development
» Scope of Work Development
» Program Development Management
» Engineering Design and A&E Team 

Evaluations
» Estimating
» Budgeting  
» Critical Path Scheduling (MS project, 

Primavera,Clarity)

Program ManagementProgram Management
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COMMDEX’s Construction Engineering service works with you to design 
cost efficient, fault tolerant and intrinsically safe telecommunications facilities. 
Backed by our highly experienced teams of engineers, planners and managers, we 
offer a full range of pre-, during and post-construction services under the umbrellas 
of Facilities Planning and Construction Management.

During the pre-construction phase, our Facilities Planning Consultants will analyze 
your requirements to create a forward-thinking design that will satisfy today’s needs 
and be flexible enough to accommodate future growth.  Working directly with your 
user groups, we will help you design cost efficient, fault-tolerant and intrinsically 
safe telecommunications facilities including cell sites, control offices, dispatch 
centers and master switches.  

During the construction phase, our Construction Management services provide you 
with the appropriate expertise required to minimize risk and ensure quality 
construction throughout the building process.  We will be your “eyes and ears on 
the ground” to manage the infrastructure construction and ensure quality 
construction and cost savings throughout the building process.

Facilities Planning

Construction Management

COMMDEX’s Construction Engineering service works with you to design 
cost efficient, fault tolerant and intrinsically safe telecommunications facilities. 
Backed by our highly experienced teams of engineers, planners and managers, we 
offer a full range of pre-, during and post-construction services under the umbrellas 
of Facilities Planning and Construction Management.

Facilities Planning
During the pre-construction phase, our Facilities Planning Consultants will analyze 
your requirements to create a forward-thinking design that will satisfy today’s needs 
and be flexible enough to accommodate future growth.  Working directly with your 
user groups, we will help you design cost efficient, fault-tolerant and intrinsically 
safe telecommunications facilities including cell sites, control offices, dispatch 
centers and master switches.  

Construction Management
During the construction phase, our Construction Management services provide you 
with the appropriate expertise required to minimize risk and ensure quality 
construction throughout the building process.  We will be your “eyes and ears on 
the ground” to manage the infrastructure construction and ensure quality 
construction and cost savings throughout the building process.

Construction Engineering Solutions
Facilities Design

 
 
 
 
 
 

Management of 
Pre-construction Activities

 
 
 
 
 
 
 
 
 

» Value engineering & constructability analysis
» Mission critical data center design
» Control center design
» Grounding and surge protection
» Electrical and backup power (UPS and generator)
» (N+1)2 redundancy designs

» Site visits
» Site acquisition
» Zoning approvals
» Regulatory (FAA, FCC, NEPA, SHPO ) permits
» Construction drawings
» Material ordering (antenna, lines, equipment, etc.)
» Bidding and contractor selection
» Construction estimating and budget preparation
» Detailed construction schedules

Facilities Design
» Value engineering & constructability analysis 
» Mission critical data center design 
» Control center design 
» Grounding and surge protection 
» Electrical and backup power (UPS and generator) 
» (N+1)2 redundancy designs 

Management of 
Pre-construction Activities
» Site visits 
» Site acquisition 
» Zoning approvals 
» Regulatory (FAA, FCC, NEPA, SHPO ) permits 
» Construction drawings 
» Material ordering (antenna, lines, equipment, etc.) 
» Bidding and contractor selection 
» Construction estimating and budget preparation 
» Detailed construction schedules 

Management of Construction Activities

Disaster Recovery Planning

» Site/utility/construction permit coordination
» Ongoing monitoring and site/technical inspections
» Manage change order applications
» Coordinate offsite storage facilities 
» Claim resolution 
» Monitor and manage safety and accident 

prevention programs
» Ongoing organized record keeping
» Implement and manage quality review program
» Ensure strict conformity of all laws, rules and regulations

» Analysis of existing facilities
» Analysis of single points of failure
» Backup power and grounding analysis
» Reliability and redundancy evaluations
» Fault tolerant design        

Management of Construction Activities
» Site/utility/construction permit coordination
» Ongoing monitoring and site/technical inspections
» Manage change order applications
» Coordinate offsite storage facilities 
» Claim resolution 
» Monitor and manage safety and accident 

prevention programs
» Ongoing organized record keeping
» Implement and manage quality review program
» Ensure strict conformity of all laws, rules and regulations

Disaster Recovery Planning
» Analysis of existing facilities
» Analysis of single points of failure
» Backup power and grounding analysis
» Reliability and redundancy evaluations
» Fault tolerant design        

Construction EngineeringConstruction Engineering
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ALABAMA

ARIZONA

DELAWARE

FLORIDA

GEORGIA

ILLINOIS

KENTUCKY

 Calhoun County, 800 MHz Voice System
» Southern Company iDEN System

» DHS Mt Lemmon Project

`» State of Delaware 800 MHZ SmartZone 
Simulcast Astro Radio System

» State of Florida, Statewide Motobridge 
Interoperability Project

» Osceola County 800 MHZ Trunked 
SmartNet Radio

» Orange County 800 MHZ Trunked 
SmartZone Radio

» Orlando 800 MHZ Trunked SmartZone 
Radio

» State of Georgia, Converged 
Communications Out-
sourcing Project

» Metropolitan Atlanta Rapid Transit 
Authority (MARTA), 800 MHz 
Simulcast System

» Southern Company iDEN System
» Lowndes County, 800 MHZ Trunked 

Digital Simulcast Radio System
» Dekalb County, Astro 25 Simulcast 

System Upgrade
» Hall County, 800 MHz Project 25 

Simulcast System

» AT&T Outside Plant E140 Cable Project

» Metro Louisville, Public Safety Radio 
Network

»
MAINE

MARYLAND

MICHIGAN

MISSISSIPPI

MISSOURI

NEBRASKA

NEW YORK

NORTH CAROLINA

OHIO

MAINE

MARYLAND

MICHIGAN

MISSISSIPPI

MISSOURI

NEBRASKA

NEW YORK

NORTH CAROLINA

OHIO

» Maine Statewide Communications 
Network

» Prince George’s County, MD 800 MHz 
Trunked Radio System

» University of Maryland, 800MHz 
Trunked SMARTNET Radio System

» Montgomery County, MD 800 MHz 
Trunked Radio System

» Macomb County Wireless Voice 
Communication System

» City of Natchez-Adams County, MS 800 
MHZ Simulcast Trunked Radio System

» City  Of  Gulfport, Radio 
Communications System

» Southern Company, iDEN System 
» MS Statewide Wireless Interoperability 

Network

» AT&T Outside Plant E140 Cable Project

» AT&T Outside Plant E140 Cable Project

» New York Channel 16
» Tompkins County Mixed Mode 

Simulcast System

» City of Burlington, Smartzone 
Simulcast Radio System

» State of Ohio, MARCS Expansion Project

» Maine Statewide Communications 
Network

» Prince George’s County, MD 800 MHz 
Trunked Radio System

» University of Maryland, 800MHz 
Trunked SMARTNET Radio System

» Montgomery County, MD 800 MHz 
Trunked Radio System

» Macomb County Wireless Voice 
Communication System

» City of Natchez-Adams County, MS 800 
MHZ Simulcast Trunked Radio System

» City  Of  Gulfport, Radio 
Communications System

» Southern Company, iDEN System 
» MS Statewide Wireless Interoperability 

Network

» AT&T Outside Plant E140 Cable Project

» AT&T Outside Plant E140 Cable Project

» New York Channel 16
» Tompkins County Mixed Mode 

Simulcast System

» City of Burlington, Smartzone 
Simulcast Radio System

» State of Ohio, MARCS Expansion Project

PENNSYLVANIA

SOUTH CAROLINA

TENNESSEE

VIRGINIA

WASHINGTON DC

WEST VIRGINIA

PENNSYLVANIA

SOUTH CAROLINA

TENNESSEE

VIRGINIA

WASHINGTON DC

WEST VIRGINIA

» Beford County, UHF Public Safety 
Radio Network

» Statewide Radio System
» York County 800 MHz Simulcast System

» Shelby County, TN 800 MHz ASTRO 
Trunked Simulcast System

TEXAS

» IBM Texas Microwave Project
» City of Houston, 700/800 MHZ 

Trunked Radio System

» Commonwealth of Virginia, Statewide 
Agencies Radio System (STARS)

» York County and James City County, 
800 MHz P25 Simulcast System

» Prince William County, 800 MHz 
SmartNet Simulcast Astro Digital 
System

» Hanover County, VA 800 MHZ Astro 
Simulcast Trunked Radio System

» King George County, Upgrade To 
Conventional VHF Simulcast Radio 
System

» Washington DC Metropolitan Area 
Rapid Transit Authority (WMATA) 490 
MHZ Comprehensive Radio System

» DC Fire and Police Joint 
Communications System

» West Virginia Statewide Interoperability 
Radio Project

» Beford County, UHF Public Safety 
Radio Network

» Statewide Radio System
» York County 800 MHz Simulcast System

» Shelby County, TN 800 MHz ASTRO 
Trunked Simulcast System

TEXAS

» IBM Texas Microwave Project
» City of Houston, 700/800 MHZ 

Trunked Radio System

» Commonwealth of Virginia, Statewide 
Agencies Radio System (STARS)

» York County and James City County, 
800 MHz P25 Simulcast System

» Prince William County, 800 MHz 
SmartNet Simulcast Astro Digital 
System

» Hanover County, VA 800 MHZ Astro 
Simulcast Trunked Radio System

» King George County, Upgrade To 
Conventional VHF Simulcast Radio 
System

» Washington DC Metropolitan Area 
Rapid Transit Authority (WMATA) 490 
MHZ Comprehensive Radio System

» DC Fire and Police Joint 
Communications System

» West Virginia Statewide Interoperability 
Radio Project

Comprehensive Telecom Solutions, Nationwide 
There’s no substitute for experience.

Experience ProfileExperience Profile
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Client SatisfactionClient Satisfaction

At Commdex, our customer's goals are our 
passion - we embrace your objectives, commit to 
your mission and always act in your best 
interests. We listen intently and innovate to help 
you achieve your objectives utilizing leading-
edge technology and the most up-to-date 
methodologies. Our responsiveness to our 
clients’ needs and our commitment to always 
provide the right solution the first time are why 
our customers choose us for repeat business year 
after year.

What They’re Saying 
About Commdex
“…superb job. Well organized, knowledgeable and resourceful. 
He thinks “out of the box” to find solutions to potential problems. 
He understands our processes and works hard to satisfy those 
requirements”
Ron Faulkner

“Congratulations, all internal clients, to date, have been satisfied 
with Commdex's performance and would use Commdex again.  
Your past performance and the acceptance of your Motorola 
clients to use you again, is the reason I am contacting you.  I 
would like to establish Commdex as a “preferred” supplier to 
Motorola.”
Tami Martin
Global Procurement Business & Financial Consulting Service
Senior Program Manager

Senior Program Manager

“...absolutely indispensable in these opportunities, especially when 
we have to be very creative to win the business.  My gratitude for 
his selfless efforts for the long hours required, as well as his 
expertise and positive attitude/enthusiasm.”
Saiid Anhary
Systems Integration Specialist

“Thank you for your leadership in making this happen.”
Scott Adler
Vice President, Motorola

“Yesterday, you achieved a major breakthrough by successfully 
testing proper operation of...... We all appreciate your enthusiasm, 
energy, and attention-to-detail in completing these important 
milestones.”
Jerry Masak 
RF Engineering Manager 

“I wanted to take a moment to thank you for your invaluable 
contribution. You were instrumental in completing this task ahead 
of schedule by skillfully coordinating with over 39 departments in 
the County. Completion of this crucial task ahead of schedule has 
greatly facilitated the completion of staging and other important 
tasks in a timely and expeditious manner. I look forward to 
working with you on future projects and further utilizing the 
advanced skills and resources offered by Commdex Consulting.”
Art Harris
Project Manager

“Many thanks for a truly outstanding effort”
Joe Gordon
Account Executive

“Congratulations on completing the impossible ahead of schedule”
Mike Repella
Pre-sales Business Manager
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